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Getting to know iSeries Navigator

iSeries™ Navigator is a powerful graphical interface for Windows® clients.

With iSeries Navigator, you can use your graphical interface skills to manage and administer your
servers.

Here is an example of the iSeries Navigator main window:
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From this example, you can see the iSeries Navigator hierarchical tree view in the left pane of the
window. It provides a familiar user interface for those experienced in using graphical interfaces. It also
decreases the need for users to learn the character-based interface. iSeries Navigator functionality includes
system navigation, configuration, systems management, and monitoring capabilities. For step-by-step
instructions on how to perform tasks in iSeries Navigator, see the iSeries Navigator online help.

What’s new for iSeries Navigator in V5R4

See a summary of the new and changed information in the V5R4 Information Center for iSeries
Navigator.

New and changed information in the V5R4 Information Center for iSeries Navigator includes:

[Requirements for installing iSeries Navigator|
Updated PC hardware and software requirements.

liSeries Navigator functions by release|
Formerly available from the iSeries Navigator Web page, this table (which shows what functions
are available for each release of i5/0S™") is now part of the iSeries Information Center. When you
are using iSeries Navigator, you will find that the functions available for any iSeries server you
are connected to are dependent on which version of i5/0S is running on that server.

liSeries Navigator tasks on the Web|
You can now access and perform a subset of iSeries Navigator tasks through an Internet Web
browser. The interface may look slightly different, but the tasks you can perform are the same.
The following iSeries Navigator functions are available to work with on the Web:

* Messages, User Jobs, and Printer Output (in Basic Operations)

* Active Jobs, Server Jobs, Output Queues, and Subsystems (in Work Management)
* System Values and Time Management (in Configuration and Service)

* Database Objects in (Databases)

[Intelligent Agents console|
System administrators can now manage one or more ABLE (Agent Building and Learning
Environment) agents running on a single system or across a distributed platform. This new topic
in the iSeries Information Center provides more information about ABLE agents, setting up your
agent environment, and using the Intelligent Agents console in iSeries Navigator.

In addition to the information in the|[Functions by release| table, see the following for more information
about what new functions are available in V5R4 for iSeries Navigator:

liSeries Technical Supportl‘@
Web site Look under Library in the left navigation bar, and then under iSeries Technical
Overviews, for a more technical description of the new functions in V5R4.

iSeries Navigator online help
In iSeries Navigator, click Help » Help Topics > What’s new? to review all the new functions
available in iSeries Navigator this release.

See also the following topics:

* [iSeries Navigator for Wireless - What’s new for V5R4|
* [iSeries Navigator tasks on the Web -- What's new for V5R4|
+ [Management Central -- What's new for V5R4?|
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How to see what’s new or changed

To help you see where technical changes have been made, this information uses:
* The ¥ image to mark where new or changed information begins.
* The 4% image to mark where new or changed information ends.

To find other information about what’s new or changed this release, see the

Printable PDF

Use this to view and print a PDF of this information.

To view or download the PDF version of this document, select |Getting to know iSeries Navigator| (about
422 KB).

Other information

You can also view or print any of the following Redbook PDFs:

+ Managing OS/400® with Operations Navigator V5R1 Volume 1: Overview and More| %

+ Managing OS/400 with Operations Navigator V5R1 Volume 2: Security] @‘

+ Managing OS/400 with Operations Navigator V5R1 Volume 3: Configuration and Service] @

+ Managing OS/400 with Operations Navigator V5R1 Volume 4: Packages and Productg Q

+ Managing OS/400 with Operations Navigator V5R1 Volume 5: Performance Management] Q‘

+ Managing OS/400 with Operations Navigator V5R1 Volume 6: Networking] %

Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF in your browser (right-click the link above).

2. Click Save Target As if you are using Internet Explorer. Click Save Link As if you are using Netscape
Communicator.

3. Navigate to the directory in which you would like to save the PDFE.
4. Click Save.

Downloading Adobe Acrobat Reader

You need Adobe Acrobat Reader to view or print these PDFs. You can download a copy from the
(www.adobe.com/products/acrobat/ readstep.html)‘@ .

iSeries Navigator - Functions by Release

When you are using V5R4 iSeries Navigator, you will find that the functions available for any iSeries
server you are connected to are dependent on which version of i5/0S is running on that server. See this
table to find out which functions are available for each release of i5/0S.

Function Description V5R2 V5R3 V5R4
Management Central
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Function
Management Central

Monitors

Commands

Packages

Hardware and Software

Inventory

Fixes Inventory

Scheduling

Collection Services

System Values

Description V5R2
Manage multiple iSeries systems. @

System Monitors - Monitor real-time performance a
of one or more iSeries servers.

Job Monitors - Monitor jobs on one or more 0
iSeries servers.

Message Monitors - Monitor messages on one or 0
more iSeries servers.

B2B Activity Monitors - Monitors your B2B 0
transactions.

File Monitors - Monitors files for any changes, or 0
for specific text strings.

Graph History - Provides a graphical view of 0
performance data collected over days, weeks,

months, or years.

Run and save commands.

Create, save, and distribute objects.
Collect and display inventory.
Manage software fixes (PTFs).
Schedule Management Central tasks.

Collect performance data.

Display, change, and distribute system values.

S & Q0 & & & Q

V5R3 V5R4

S & Q@ & & 0 & 2 & & &0 & QO ¢
S & Q@ & & 0 & 2 & & & & Q0 ¢
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Function
Distributed User and
Group Administration

Licensed Program
Installation

Extreme Support

SSL Support

Synchronize Date and
Time

Cluster Proven

Synchronize EIM and
Kerberos Configurations

Description V5R2
Create, change, and distribute users and groups. @

Create LPs and fixes, distribute and install. 0
Secure, personalized service and electronic &
support.

Secure transmissions between a central system 0
and endpoint systems.

Enhanced SSL and Authentication - sign on to
one system and be recognized by others.

Synchronize date and time system values across a 0
network of iSeries servers using Compare and
Update System Values.

High availability for Management Central when
running in a cluster environment.

Use the Synchronize Functions wizard to
duplicate your EIM and Kerberos configurations
from a model system to your endpoints.

iSeries Navigator for Wireless

iSeries Navigator for
Wireless

Remotely monitor system performance and a
status.

iSeries Navigator Tasks on the Web

iSeries Navigator Tasks
on the Web
Basic Operations

Select iSeries Navigator tasks directly accessible
from a Web browser.

Manage i5/0S messages, printer output, printers,
and jobs.

Messages

Printers

Printer output

6  IBM Systems - iSeries: Connecting to iSeries Getting to know iSeries Navigator
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Function

Command Prompter

Work Management

Database

Description
Jobs

Prompt for CL commands from the Web.

Manage daily system operations and workload.

Active jobs

Server jobs

Job queues

Subsystems

Output queues

Memory pools

System status

Administer DB2 Universal Database” for iSeries

from the Web.

Tables, objects, views, journals, and indexes

Constraints

Sequences

V5R2

V5R3 V5R4

Q Q& & d 0 Q0 0
Q Q& @ d QOO0

Q & & 2

Getting to know iSeries Navigator
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Function

Hardware

Network

Intelligent Agents
Intelligent Agent
Support

Description
SQL procedures and packages

Schemas

Database performance monitors

Import and export data

Manage your iSeries hardware from the Web.

Configuration and service

Manage your i5/0S TCP/IP configuration and

other communications from the Web.

TCP/IP servers

Universal connection wizard

Create and manage autonomic Java™ agents to
maintain your iSeries servers.

Application Administration

Application
Administration

Administration of
Plug-ins

Centralized

Administration

Basic Operations
Basic Operations

Control user’s access to functions.

Control user’s access to iSeries Navigator
plug-ins.

Define an administration system to centralize
your Application Administration settings.

Manage lists of messages, printer output, and
printers.
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Function
Messages

Printers

Printer Output

AFP"™ Workbench
Viewer

Jobs

Job logs

Command Prompter
Graphical CL Command
Prompter

Work Management
Work Management

Active Jobs

Description
Work with messages.

Manage printers.

Work with printer output.

Cut, copy, paste, drag and drop, printer output.

Displays printer output.

Work with user jobs.

Display job log for a job.

Prompt for CL commands within iSeries
Navigator.

Manage system operation and the daily workload

on the system.

Work with active jobs.

Call Stack - View the call stack for an active job.

Library List - View the library list for an active
job.

Locked Objects - Work with the object locks for
an active job.

Open Library Objects - View and work with the
open library objects for an active job.

Q & Q Q@ & @ Q@ Q @ Q@ Q& & & 0

V5R3 V5R4

Q Q@ 0 d & ¢ d d G Q@ @
Q Q@ 0 2 & ¢ 0 d 0 O & Q@ @
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Function Description V5R2 V5R3 V5R4
Open File System Objects - View and work with
the open file system objects for an active job.

Elapsed Performance Statistics - Monitor job &
performance using Elapsed Performance
Statistics.

Threads - Work with threads running under an &
active job.

Transactions - Work with transactions attached to 0
an active job.

Last SQL Statement - Work with last SQL 0
statement that was run by an active job.

Server Jobs Work with server jobs. 0
Job Queues Work with active and all job queues. @
Subsystems Work with active subsystems. 0
Memory Pools Work with memory pools. a
Output Queues Work with all output queues on the system. 0
System Status Quickly and easily check the status of a system. 6
Hardware

Configuration and Manage hardware and software on your system. a
Service

System Values - Work with all system values. @

Time Management - Adjust time and manage
time zones.

Q & @ @ 0 d QO QO 20
Q & @ @ 0 d 2 0 Q000 0
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Function

Disk Management

LPAR Configuration

Simple Cluster
Configuration

Description V5R2
Hardware Inventory - Display the hardware for 0
the system.

Software Inventory - Display the software for the 0
system.

History Log - Display messages in the system
history log.

Manage the disk units on your system. 6
Work with disk unit balancing, status, and 0
capacity.

Manage disk units, HSM, and compression. Add,
move, and remove disk units.

Set up and manage independent disk pools. 0
Graphical View - Displays all disk units in a 0
parity set, mirrored pairs, active, and more.

Print the graphical view.

Parity Sets - Start, stop, and resynchronize parity. 0
Parity Sets - Change parity optimization.

Geographic Mirroring - Mirror independent disk

pools to systems at other sites.

Configure and manage local partitions. @

Configure and manage two-node clusters. 0

Getting to know iSeries Navigator
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Function
Tape Devices

Network
Network Functions

Enterprise Identity
Mapping (EIM)

Description V5R2
Support for stand-alone tape devices and tape 6
libraries.

Tape image catalogs.

Virtual tape devices.

Manage your i5/0S TCP/IP configuration and 3
other communications interfaces using wizards,
configure new servers, and start servers in one

step when TCP/IP starts.

Access iSeries Internet applications like IBM® @
Web Administration for iSeries.

Manage point-to-point communications. @
Set up and manage TCP/IP interfaces. 3

Set up and manage server applications, which
includes: DNS, DHCP, iSeries NetServer ", NFS,
DCE, Directory server (LDAP).

Set up and manage IP security. a

Set up virtual private networking (VPN). @

Manage additional IP interface and line types 6
(PPP for example) over L2TP and ISDN, WAN
and Circuitless IP.

Manage TCP/IP quality of service. 6
NetStat - Detailed information for interfaces, 0
routes, connections, physical interface activity.

Inexpensive cross-platform single sign-on. 0
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Function

Description

Create and manage mapping policies.

Test EIM mappings.

Support for x.509 and Digital Certificates.

Integrated Operating Environments

Integrated operating
systems and
environments

Security
Security

Permissions

Security Policies

Security Configuration

Wizard

Users and Groups

Manage your Windows server on an Integrated
xSeries® Server.

Support for integrated xSeries Servers.

Integrated server management - start and stop

integrated servers, status.

Manage users and disk storage for your

integrated servers.

Manage integrated AIX® and Linux® servers.

Support for xSeries servers and BladeCenters

with iSCSI technology.

Object authority and security system values.

Manage object authority.

Maintain security and auditing policies.

Configure security.

Manage i5/0S users and groups.

V5R2 V5R3

Q & & @

Q @ ¢ & &

Q & 0 & & & 0 0

Q Q& & &

9
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Function

SSL Support

Network Authentication
Service

Object Signing and
Signature Verification

Database
Database Support

Multiple Databases

Manage DB2® UDB
Objects

Reorganize Tables

SQL

Description V5R2
Use SSL to secure iSeries server applications. @
Easily create and manage Kerberos tickets to 0
authenticate users

Create and manage keytab entries.

V]

Administration of DB2 Universal Database (UDB)
for iSeries.

Multiple databases now supported using 6
independent disk pools.

Work with complex objects, procedures, and &
functions.
Tables, views, journals, indexes, and aliases. a

Sequence objects, partitioned tables, check
pending constraints, materialized query tables
and more.

Objects organized by container.

Stop, resume, and view progress of table
reorganization.

Create, save, and run SQL scripts. @

Collect and view SQL performance data using 0
SQL performance monitors.

View the SQL statements used to perform
database actions using Show SQL.
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Function Description V5R2 V5R3 V5R4

Library support enhanced to support SQL object &
schema.
Visual Explain Visual description of queries. 0 0
Database Navigator Visual description of your database. a &
iSeries Graphical Launch and run from SQL scripts. 0
Debugger
Health Center Use SQL schemas to test table size limits.
Index Advisor Display index advised information from CQE
and SQE.

Integrated File System (IFS)
Integrated File System Work with the iSeries integrated file system.

Cut, copy, paste, create, and Rename IFS files.

Drag and drop, cut, copy, and paste QSYS

objects.

File Shares List and work with NetServer File Shares.

Additional Attributes Display object attributes.

Q @ Q& &

Virus Scanning Provides support for scanning files using
third-party virus scanning software.

Advanced Function Printing™ (AFP)

S Q & Q@ 0 d & Q 0 0 Q> Q> 0

S Q@ & @ 0 &

AFP Manager AFP resources, font mapping tables, PSF. 0
Intelligent Routing Specify any combination of stream file, spooled
file, or e-mail for PDF output file. 0 & &
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Function Description V5R2 V5R3 V5R4
Backup
Backup Schedule backups. 0

Backup, Recovery and Media Services (BRMS)
Backup, Recovery and ~ BRMS Licensed Program (iSeries Navigator @
Media Services (BRMS)  plug-in).

Global policy properties ﬁ

View and save HTML-based reports.
Reclaim media

Manage devices

Backup policy omits of folders, libraries, and
library objects.

Restore printer output and archive objects

Application Development

Q ¢ ¢ d QOO G 0
Q Q& @ ¢ d Q> QO G 0

Application Work with application development tools. 0
Development

Plug-in Support

Java Create plug-ins using Java. &
C++ Create plug-ins using C++. 0
Visual Basic Create plug-ins using Visual Basic. 0

Requirements for installing iSeries Navigator

Review the PC hardware and software requirements to install iSeries Navigator.

To install and use iSeries Navigator, your PC must be running one of the following Windows operating
systems:
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Windows N 4.0

Windows 2000

Windows XP

Windows Server 2003 (32-bit PC)
Windows Server 2003 (64-bit PC).

See Prerequisites to set up the PC for iSeries Access for Windows for the processor, memory, and service
pack level requirements for each operating system.

Related concepts

[Prerequisites to set up the PC for iSeries Access for Windows|
Related tasks
[“Installing iSeries Navigator”|

Get started managing and administering your server from your PC. Once installation is complete,
task-based information is available in the iSeries Navigator online help.

Installing iSeries Navigator

Get started managing and administering your server from your PC. Once installation is complete,
task-based information is available in the iSeries Navigator online help.

All iSeries Navigator components are packaged with iSeries Access for Windows. Assuming that your PC
meets the hardware and software requirements, your first step is to install the iSeries Navigator
components when you install iSeries Access for Windows on your PC.

Note: You need to have iSeries Access for Windows installed on the system from which you install
iSeries Navigator. However, iSeries Access for Windows is not required on the systems that you
connect to with iSeries Navigator. The only software requirement for these systems is the i5/0S
host servers option (Option 12 when you install the i5/OS operating system).

To install iSeries Navigator on your PC, follow the instructions to install iSeries Access for Windows on
your PC. If you are installing iSeries Navigator for the first time, be sure to make these selections:

1. Select the Custom installation option during iSeries Access for Windows installation.

2. In the Component Selection window, only some of the subcomponents of iSeries Navigator are
preselected to be installed. Click the gray box next to iSeries Navigator to remove the default
selections.

3. Click the box next to iSeries Navigator again. This selects all of the individual iSeries Navigator
subcomponents.

4. Deselect any subcomponent that you do not want installed.

If you have a previous release of iSeries Navigator installed on your PC, you can choose the Basic
Upgrade installation option to upgrade your previously installed components to the new release. To add
or remove components, choose Selective Upgrade.

Related concepts

fiSeries Access for Windowrs|

[“Requirements for installing iSeries Navigator” on page 16|
Review the PC hardware and software requirements to install iSeries Navigator.

[“Working with iSeries Navigator” on page 18|
See an overview of the capabilities that iSeries Navigator provides, which are covered in the
Information Center.

Related tasks
[[nstall iSeries Access for Windows on your PC|

Getting to know iSeries Navigator 17



Installation tips

* If you select the Typical installation option, only the following iSeries Navigator components will be
installed:

— iSeries Navigator base support
— Basic operations (messages, printer output, printers, and jobs)
* To install additional components after you install iSeries Navigator, use iSeries Access Selective Setup.

* If you are having trouble reading the fonts on some windows, try using a screen resolution of 1024x768
or higher.

Once you have completed installing iSeries Navigator, you will need to add server connections. To add
connections to iSeries Navigator:

1. Double-click the iSeries Navigator icon on your Windows desktop.
2. Click Yes to create a connection.

3. Follow the instructions in the Add Connection wizard.

4

To add another server connection, click File » Connection to Servers > Add Connection in the iSeries
Navigator main window.

Once you have iSeries Navigator up and running, refer to the iSeries Navigator online help for specific
task-based information.

Working with iSeries Navigator

See an overview of the capabilities that iSeries Navigator provides, which are covered in the Information
Center.

iSeries Navigator provides a powerful suite of functions to handle your system administration tasks.
Once you have installed iSeries Navigator, use the online help for step-by-step instructions for all the
individual tasks that you can do "the GUI way” in iSeries Navigator. In the main iSeries Navigator
window, just click Help » Help Topics » What can I do with...?

For links to related conceptual information in the Information Center, keep reading!

iSeries Navigator concepts

Manage multiple systems The Management Central technology, which is an integral part of
iSeries Navigator, allows you to manage tasks across one or more
servers simultaneously. Simplify your systems management with
task scheduling, real-time performance monitoring, managing
fixes (or PTFs), distributing objects, managing users and groups,
running commands from a central system, and much much more.

Manage logical partitions Use iSeries Navigator to access your logical partition information,
change logical partition configuration, manage security, and
change processing resources without requiring a system restart.
On an iSeries server, you can use iSeries Navigator, DST, and SST
to manage your logical partitions. If you are working with
partitions on IBM Systems and eServer ~ hardware, or models
such as 5xx, see Partitioning the server for more information.
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iSeries Navigator concepts
Manage your hardware

Secure your network

Work with database records

Connect your network

Manage your system workload

Limit application availability

Related concepts

[Management Centrall

[Disk units and disk pools

Use iSeries Navigator to configure, protect, and manage all of
your disk units and disk pools, as well as work with mirroring
and parity protection. iSeries Navigator also allows you to view
all stand-alone devices as well as all the tape resources and
cartridges within your tape libraries. Using iSeries Navigator, you
can duplicate tapes, display or print volume labels, eject a tape
from a tape library, format a tape, make a tape cartridge or device
(vary it on), make a tape device unavailable (vary it off), print
save-or-restore-tape information, print volume contents, and reset
tape resources.

Network security means that your customers, employees, and
business partners can obtain the information that they need to do
business with you in a secure environment. iSeries Navigator has
several integrated features that will help build a strong defense
against the security risks you may encounter along the way. Use
iSeries Navigator to configure everything from your basic system
security policy to secure end-to-end VPN connections, filter rules,
address translation, SSL, enterprise identity mapping, and much
more.

You can perform many of your database tasks using iSeries
Navigator. These tasks include creating and maintaining database
objects, inserting or changing data, monitoring and analyzing
query performance, and creating a map of your database. See
Getting started with iSeries Navigator Database for more details.

Use the Network component of iSeries Navigator to configure and
manage network communications on your server. Find wizards to
easily configure the interfaces, routes, and servers that are
necessary for network communications. Verify connectivity using
the PING and trace route utilities. Then, choose from a variety of
functions to customize the network; for example, you may select
IP policies to control and secure your network traffic using QoS
or VPN, or choose Remote Access Services to create point-to-point
connections. See Networking for detailed information about
various networking technologies that you can use on the iSeries.

System jobs are created by the operating system to control system
resources and perform system functions. System jobs run when
the iSeries server starts, without user input. These jobs perform a
variety of tasks from starting the operating system, to starting and
ending subsystems, to scheduling jobs. See Managing jobs for
information about managing jobs.

Application Administration allows administrators to limit or grant
access to functions, including several iSeries Navigator functions,
and other applications for the users and groups on a specific
iSeries server. Administrators can also centrally manage many of
the properties used by iSeries Access for Windows clients and use
the advanced Application Administration settings to centrally
control environment, password, connection, service, and language
settings.
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ape librarie:

[Network security]|

[Getting started with iSeries Navigator Database]

Qo]

N

Remote Access Services|
Networkingl

:Sistem i'obsl

:Manaéiné i'obsl

[Application Administration|
Related tasks

[“Installing iSeries Navigator” on page 17
Get started managing and administering your server from your PC. Once installation is complete,
task-based information is available in the iSeries Navigator online help.

[Manage your logical partitions|

[Partitioning the server]

Related information for iSeries Navigator

Follow the links in this topic to find related technical information in IBM Redbooks™, in other
Information Center topics, and on IBM Web sites.

Listed below are the IBM Redbooks (in PDF format), Web sites, and Information Center topics that relate
to the iSeries Navigator topic. You can view or print any of the PDFs.

Redbooks

+ Managing OS/400 with Operations Navigator V5R1 Volume 1: Overview and More|$

+ Managing OS/400 with Operations Navigator V5R1 Volume 2: Security] @

+ Managing OS/400 with Operations Navigator V5R1 Volume 3: Configuration and Service] @

+ Managing OS/400 with Operations Navigator V5R1 Volume 4: Packages and Productg %

* Managing OS/400 with Operations Navigator V5R1 Volume 5: Performance Management] @‘

+ Managing OS/400 with Operations Navigator V5R1 Volume 6: Networking]| %

Web sites

* [iSeries Navigator home page|-® .

Other Information Center topics

* [iSeries Navigator for Wireless| (about 650 KB)

+ [iSeries Navigator tasks on the Web|(about 150 KB)
* |Application Administration| (about 200 KB)

* Management Central| (about 250 KB)

— |Performance| (about 1100 KB)

— [Software and licensed programs| (about 350 KB)

+ [Developing iSeries Navigator plug-ins| (about 360 KB)
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Saving PDF files

To save a PDF on your workstation for viewing or printing:
1. Right-click the PDF in your browser (right-click the link above).

2. Click Save Target As if you are using Internet Explorer. Click Save Link As if you are using Netscape
Communicator.

3. Navigate to the directory in which you would like to save the PDF.
4. Click Save.

Downloading Adobe Acrobat Reader

You need Adobe Acrobat Reader to view or print these PDFs. You can download a copy from the
(www.adobe.com/products/acrobat/ readstep.html)'@ .
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing

2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
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Software Interoperability Coordinator, Department YBWA
3605 Highway 52 N

Rochester, MN 55901

US.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this information and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement,
IBM License Agreement for Machine Code, or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to change before the
products described become available.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

Trademarks

The following terms are trademarks of International Business Machines Corporation in the United States,
other countries, or both:

Advanced Function Printing
AFP

AIX

DB2

DB2 Universal Database
eServer

i5/0S

IBM

iSeries

NetServer

0S/400

Redbooks

xSeries
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Windows, is a trademark of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.

Terms and conditions

Permissions for the use of these publications is granted subject to the following terms and conditions.

Personal Use: You may reproduce these publications for your personal, noncommercial use provided that
all proprietary notices are preserved. You may not distribute, display or make derivative works of these
publications, or any portion thereof, without the express consent of IBM.

Commercial Use: You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make derivative works of
these publications, or reproduce, distribute or display these publications or any portion thereof outside
your enterprise, without the express consent of IBM.

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either
express or implied, to the publications or any information, data, software or other intellectual property
contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use of
the publications is detrimental to its interest or, as determined by IBM, the above instructions are not
being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable
laws and regulations, including all United States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE
PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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